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Chapter 1

Administering
QuickBooks

uickBooks doe: something that’s critically important to the success of

your businesz: it collects and supplies financial information. For this rea-

son, yot waut to have a firm understanding of how you can protect the
data that Quicklcoks collects and stores, as well as the assets that QuickBooks
tracks. This chapter describes all this.

Keeping Your Data Confidential

Accounting data is often confidential information. Your QuickBooks data shows
how much money you have in the bank, what you owe creditors, and how much
(or how little) profit your firm produces. Because this information is private, your
first concern in administering a QuickBooks accounting system is keeping your
data confidential.

You have two complementary methods for keeping your QuickBooks data con-
fidential. The first method for maintaining confidentiality relies on the security
features built into Microsoft Windows. The other method relies on QuickBooks’s
security features.

CHAPTER 1 Administering QuickBooks 485



486

TIP

Using Windows security

You can use the security provided by Windows to restrict access to a file — either
a program file or a data file — to specific users. This means that you can use
Windows-level security to say who can and can’t use the QuickBooks program or
access the QuickBooks data file.

I don’t describe how Windows-level security works in this book. If you’re already
employing Windows-level security, you know (or someone in your office knows)
how to use that tool to prevent unauthorized access to, or use of, program files
and data files. To use Windows-level security for QuickBooks, you can simply
apply your existing general knowledge to the QuickBooks program file or the
QuickBooks data file.

If you aren’t already using Windows-level security, you don’t need to go to the
trouble of learning Windows’s complicated security systein. You can use the sim-
pler QuickBooks security.

Using QuickBooks secuiity

You can protect the confidentiality of vuur QuickBooks data by assigning a pass-
word to a QuickBooks company date file. You can do this during the QuickBooks
setup process. You can also set v'p 1 password by choosing the Company > Change
Your Password command. In non-Enterprise versions of QuickBooks, the com-
mand would be Company 3et Up Users & Passwords= Change Your Password.
When you choose this ¢srmand, QuickBooks displays the Change Your Password
dialog box (see Figuie1-1).

To set up a password, you simply enter the same password in both the New Pass-
word text hox and the Confirm New Password text box. Note that your pass-
word is associated with the username Admin (which stands for administrator).
If you haven’t yet set up a password, you don’t have an old password, so you
won’t see a Current Password text box. If you’re working with an Administra-
tor password, you must also provide a challenge question and answer. (This
answer will let you recover your access to your QuickBooks file if you forget the
Administrator password.)

Obviously, you want to set your password so that no one (not even a computer)
can possibly guess it, which means that your password shouldn’t be a word in a
dictionary. Your password also shouldn’t be a number. And your password espe-
cially shouldn’t be a word, phrase, or name that some co-worker can easily figure
out. The best passwords (from a security point of view) are nonsensical combi-
nations of letters, numbers, and symbols such as f34t5s! or s#3df43x2. One other
thing: Longer is better.
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Change Your Password

Change QuickBooks Desktop Password

Create a new complex QuickBooks Deskiop password. You cannot reuse any of your last four
passwords. Explain

User Name 'Admln

Current Password | | Show
Forgot Password?
MNew Password

Recommended to have at least 7 characters,
including ene number and one uppercase letter.

Confirm Mew Password

FIGURE 1-1:

The Change
Your Password Cancel W

dialog box. -l

I would also consider subscribing to a pas<woird manager service, such as 1Pass-
word or Last Pass. These services allow vou to store, generate, and manage pass-
words for online services.

After you set your password,; ycii-should change it periodically. To change your
password, choose the Corn'peciy->Change Your Password (or possibly Com-
pany=Set Up Users & Roles wEdit) command. QuickBooks again displays the
Change Your Password dialog box. This time, you must enter your old password in
the Current Passwotd text box. Then you need to enter your new password in both
the New Passwnid text box and the Confirm New Password text box.

QuickBock: 12quires a username and password before it will open the company
data fiic. i* you assign a password to your company data file, for example, when-
ever QuickBooks starts, it displays the QuickBooks Login dialog box, where you
enter your username and password and then click OK. QuickBooks opens the data
file. If you can’t supply the password, QuickBooks doesn’t open the data file.

Using QuickBooks in a Multiuser
Environment

You aren’t limited to using one password to control access to your QuickBooks
data file. You can set up several passwords for the QuickBooks data file. What’s
really neat about this practice is that you can tell QuickBooks to allow certain

CHAPTER 1 Administering QuickBooks 487

Administering
QuickBooks



users and passwords to do only certain things. This sounds complicated, but it’s
really not. The business owner, for example, may have a password that allows
them to do anything. But a new accounting clerk, for example, may have a pass-
word that allows them only to record bills in the system.

Setting up additional QuickBooks users

If more than one person will be using QuickBooks, you want to set up additional
users.

Adding users in QuickBooks Enterprise Solutions

To add users in QuickBooks Enterprise Solutions, follow these steps:

1. choose Company=>Users->Set Up Users and Roles.

QuickBooks displays the Users and Roles dialog hox<{see Figure 1-2). This
dialog box identifies any users for whom QuickRceoks access has been set up
and the roles they can fill when using Quici-Bocks. The Users list, which
appears on the User List tab of the dialos box, also identifies who is currently
logged in to the system.

Users and Roles

User List =~ Role List

Uzemarme (Company file - Intuit account

{Admin®* - chistian@stepheninelsor coi tAdmin) (logge... W

Company file roles - (Admin)

Manage assigned permissions for
company fike roles

Manage permissions

Intuit account roles - isti Inelson.com)

Manage assigned rokes for
Infuit account users

Manage roles

*These users and roles have unrestricted access toview all ransactions,
including payroll info. Find out more

*These roles need an Infuit account. Read more about Intuit account
FIGURE 1-2:

The Users and Close
Roles dialog box.
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FIGURE 1-3:
The New User
dialog box.

TIP

2. Tell QuickBooks that you want to add a user by clicking the New button.
When you click this button, QuickBooks displays the New User dialog box.
3. Identify the user, and supply a password.

You need to give each user for whom you're setting up a username. You do
this by entering a short name — perhaps the user’s first name — in the User
Name box. After you identify the user, you enter the user’s password in both
the Password text box and the Confirm Password text box (see Figure 1-3).

USER NAME AND PASSWORD

LUser Name
Eassword (opfional}

Confirm Password

ROLES

Ayailable Roles Agsigned Roles )
e T
Accounts Payable '

Accounts Receivanle <<Bemove
Banking

External Accountant™

Finance™*

Description

Provide user's email address and w1 enu an invilelupdale to 2ccess Inluil account
roles.

User's email (optlonal)

*These roles give users ungsvicted accass to view all ransactions, including payrall info.
Find out more

*These roles nend anIntuit account. Read more about Intuit account

How do | middify 2\ ole? ﬁ Cancel

4. Identify the user’s role(s).

Use the Available Roles list box to select the roles (or duties) the user fills. Then
add the selected role to the user’s list of assigned roles by clicking the Add
button. To remove a role from a user, select the role in the Assigned Roles list
box and then click Remove.

The Description box at the bottom of the New User dialog box allows you to
describe the role in more detail. You might enter the type of QuickBooks user
who might typically be assigned the selected role, for example.
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FIGURE 1-4:
The Role List tab
of the Users and
Roles dialog box.

TIP

5.

Userlist Role List

Roles

EAcco unts Payable
iAcco unts Receivable
Er\umin*"

éEanki ng
EE):temaI.ﬂ’\ccountant“

(Optional) Modify roles as necessary.

You can fine-tune the roles that you assign (with the help of QuickBooks). To
do so, go back to the Users and Roles dialog box, select the Role List tab (see
Figure 1-4), click the role you want to change, and then click the Edit button.
When QuickBooks displays the Edit Role dialog box (not shown), select an
accounting activity or area in the Area and Activities list and then use the Area
Access Level radio buttons to specify what a user with the selected role can do.
You can indicate that the user should have no access by selecting the None
radio button. You can indicate that the user should have full access by selecting
the Full radio button. If the user should have partial access, you select the
Partial button and then check or clear (as appropriate) the View, Create,
Modify, Delete, Print, and View Balance check boxes. Click OK to save any
changes to the roles and return to the Users and Roles dialog box.

, =
. a
£

Do licate

Delete

Description

This role is designed for your bookkeeping or aczcunting staff. Access to
areasfactivities such as Journal Entries, Coai s Accounts, Setting Clasing
Date & Password, Accountant & Taxes and Company & Financial reports
This role needs Infuit account.

Company file user

*These users and roles have unrestricted access toview all ransactions,
including payroll info. Find out more

How do | modity a Role?

Manage permissions Close

You can see what access any role initially has by selecting one of the entries in
the Area and Activities list. QuickBooks uses the Area Access Level buttons and
boxes to show the current settings for the role.

As a general rule, when it comes to accounting controls, you want to provide a
minimal amount of access. If someone doesn't need access to the QuickBooks
data file for day-to-day duties, you should select the None button. If someone
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FIGURE 1-5:
View Permissions
window.

needs a little bit of access — perhaps to prepare job estimates or invoices —
you give just that access and nothing more. At the end of this chapter, in
“Maintaining Good Accounting Controls,” | talk about why minimizing user
rights and access is so important. But the bottom line is this: The more ability
you give employees or subcontractors or accountants to noodle around in
your accounting system, the greater the risk that someone will either inadver-
tently or intentionally introduce errors into the system. Also, the greater the
rights and access you give, the easier you make it for someone to steal

from you.

(Optional) Review your user permissions.

After you set up a user, you should (to be careful) review the permissions
you've given the user. To do this, click the User List tab of the Users and Roles
dialog box, select the user, and then click the View Permissions button. When
QuickBooks displays the View Permissions dialog box.‘not shown), select the
user and then click the Display button to see the View Permissions window
(see Figure 1-5), which displays a very detailed list of what the user can and
can't do.

Frint
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Fine Lake Porcelain LLC A
Perm.ssions Access by Users
Areas and Activitie 5 Chblock
| Accounting \ Mone
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Faquil « few s e Facime:
G Journal Hone
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7. (Optional) Review your role modifications.

If you change a role’s permissions, you probably also want to review those
changes. To do that, click the Role List tab of the Users and Roles dialog box,
select the role, and then click the View Permissions button. QuickBooks
displays another version of the View Permissions window that lists the roles
you and QuickBooks have set up. Select the role you want to review and then
click the View Permissions button. QuickBooks displays another version of the
View Permissions window, with a detailed list of what someone with the role
can and can't do.

8. After you finish reviewing user and role permissions, click Close to close
any open windows and then click the Cancel or Close button to close any
open dialog boxes.

From this point forward, the new user can use QuickBooks; their rights are
limited to what you specified.

It may be important to audit the permissions ever f2w months or years, depend-
ing on your employment turnover and bookkecniag practices. Obviously, previous
employees or bookkeepers should no longer have roles that permit them to make

TIP changes in your file. Heck, they probably <: ouldn’t have roles at all! QuickBooks’s
View Permissions window is a slick wa; o see this data online, and if you want to
print a copy of the permissions infcymation, all you need to do is click the win-
dow’s Print button.

Adding users in GuickBooks Pro and Premier

To set up additionat-users in QuickBooks Pro and QuickBooks Premier, follow
these steps:

1. choosa Inmpany=Set Up Users and Passwords->Set Up Users.

QuickBooks displays the Users and Roles List dialog box (refer to Figure 1-2),
which identifies any users for whom QuickBooks access has been set up and
who are currently logged on to the system.

2. Tell QuickBooks that you want to add a user by clicking the Add User
button.

QuickBooks displays the first Set Up User Password and Access dialog box
(not shown).

3. Identify the user, and supply a password.

Give each user for whom you're setting up a password a username by entering
a short name — perhaps the user’s first name — in the User Name box. After
you identify the user, you enter the user’s password in both the Password text
box and the Confirm Password text box.
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4.

Click Next to continue and then indicate whether you want to limit
access for the new user.

When QuickBooks displays the second Set Up User Password and Access
dialog box (not shown), indicate whether you want to limit access and rights for
the user. If you do want to limit access and rights (rights are simply the things
that the user can do), select the Selected Areas of QuickBooks radio button. If
you want the user to be able to do anything, select the All Areas of QuickBooks
radio button. If you indicate that the new user should have access to all areas
of QuickBooks, you're done setting up the user password, and you can skip the
remaining steps.

Click Next to continue and then describe access to sales and accounts
receivable information and tasks.

QuickBooks displays the third Set Up User Password and Access dialog box
(not shown) — the first of a series of dialog boxes thzt walks you through an
interview, asking detailed questions about what kiria-of access each user
should have to a particular area. With regard tc séles activity, for example,
QuickBooks asks about access to transacticns (such as invoices, credit memos,
and accounts receivable information). Yeu . cari indicate that the user should
have no access by selecting the No A=z :s radio button. You can indicate that
the user should have full access by «eiecting the Full Access radio button. If the
user should have partial access, /ou select the Selective Access radio button
and then select one of the subsidiary buttons: Create Transactions Only, Create
and Print Transactions, or: eate Transactions and Create Reports.

Click Next and then ¢'escribe the purchases and accounts payable rights.

QuickBooks diciaiays the fourth Set Up User Password and Access dialog box
(not shown). which allows you to specify what access this new user has in the
purchases and accounts payable areas. You can select the No Access radio
butten. Yeu can select the Full Access radio button. Or you can select some
middie ground by selecting the Selective Access radio button and one of the
subsidiary buttons. The same rules for setting rights and access that apply to
the purchases and accounts payable area apply to the sales and accounts
receivable area.

Click Next and then describe the remaining user rights and access.

When you click the Next button at the bottom of each version of the Set Up
User Password and Access dialog box, QuickBooks displays several other
versions of the dialog box that it uses to query you about user rights and
access. After you describe what rights are appropriate for the user in the
purchases and accounts payable area, for example, QuickBooks asks about the
checking and credit card area. Then it asks about the inventory area. Next, it
asks about payroll, followed by questions about general, sensitive accounting
activities. Finally, QuickBooks asks about access to financial

reporting capabilities.
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You limit rights in each of these other areas the same way that you do for the
sales and accounts receivable and for the purchases and accounts payable
areas. Therefore, I'm not going to describe how you select the No Access
option button, the Full Access option button, or the Selective Access button
over and over again. Just be thoughtful as you go through the screens, limiting
the user’s rights. You want users to have the rights necessary to do their job,
but you don't want to give them any more rights than they need.

8. Specify whether the user can change or delete transactions.

After you've stepped through roughly a half-dozen versions of the Set Up User
Password and Access dialog boxes that ask about specific areas of accounting,
QuickBooks displays the Changing or Deleting Transactions page of the Set Up
User Password and Access dialog box (not shown). The Changing or Deleting
Transactions page lets you indicate whether a user can change transactions
recorded before the closing date. In general, you want ta limit a user’s ability to
change or delete transactions.

9. Click Next and then review your rights decisiong.

QuickBooks displays the final version of the S<=Up User Password and Access
dialog box (not shown), which identifies the user rights that you assigned or
allowed. You can use this dialog bo: 1o rzview the rights that someone has. If
you realize that you've assigned rizhis incorrectly, click the Back button to
move back through the dialog+iaxes to the one where you made a mistake.
Change the assignment of /IS, and click the Next button to return to the
final window of the Set Un lJser Password and Access dialog box.

10. when you finish with the review of user rights and access, click Finish.

From this paintfarward, the new user will be able to use QuickBooks; their
rights are limited to what you specified.

Changing user rights in Enterprise Solutions

You can modify the rights that you assign to a user. To do this in QuickBooks
Enterprise Solutions, choose Company=> Users= Set Up Users and Roles to display
the Users and Roles dialog box (not shown).

To change a user’s rights after reviewing them, select the user and click the Edit
button. QuickBooks displays the Edit User dialog box (see Figure 1-6), which
closely resembles the New User dialog box that you use to set up the user and
describe their rights. You use the User Name, Password, and Confirm Password
text boxes to change the user information. You can use the Available Roles list, the
Assigned Roles list, and the Add and Remove buttons to change what the user can
do within QuickBooks. Click Close when you’re done.
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FIGURE 1-6:
The Edit User
dialog box.

CAPTURING RIGHTS SETTINGS

Accountants often want to see the rights that particular users have, especially if they're
auditing you as part of annual closings. (You may be audited if the bank wants audited
financial statements, for example.) QuickBooks doesn't provide a way for you to print
the information shown in the Set Up User Password and Access dialog box. Windows,
however, allows you to use the Print Screen key to capture a screen shot of the
QuickBooks program window and the Set Up User Password and Access dialog box.

Press Alt+Print Scrn to shoot a screen shot of the dialog box. This key combination cop-
ies an image of your screen to the Windows Clipboard. Next, open Paint by choosing
Start=> Programs=>Accessories=>Paint (versions before Windows 10) or Start=>Paint

3D in Windows 10. Paste the image into Paint by pressing Ctrl+V. You may see an error
message that says The image in the Clipboard is larger than the bit-
map. Would you like the bitmap enlarged? Save the s-reen shot by choosing
Filer>Save As. (This basic technique is the same one that i <'-e to show you pictures of
the QuickBooks windows in the pages of this book.) Ycu riay want to capture a screen
shot this way to record the user access and rights for =mployees.

USER NAME AND PASSWORD

LUser Name Chlock
Eassword (opfional}

Confirm Password

ROLES

Ayallable Roles Azsigned Roles

ooountantt L VPN . ccounis Pazble |
External Accountant®* EAcmunis Receivable

Finance™ I << Bemove ;Eankinsl I
Full Access™: élmﬂe ntory

Fayroll M nager {Purchasing

Fayroll Processor®

Description

This rale is designed for your Accounts Payable slalf members. Accass Lo
areas/activities such as entering and paying bills. Purchase Orders, and Vendors &
Fayables reporis.

Provide user's email address and well send an invileupdale to 2ccess Inluil account
roles.

User's email (optlonal)

*These roles give users unrestricted accass to view all ransactions, including payrall info.
Find out more

*These roles need an Intuit account. Read mors about Infuit zccount

How do | modify a Role? ﬁ Cancel
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To duplicate a user (you may want to add a second user with permissions that
mirror some other user’s permissions), in the Users and Role dialog box, select
the user you want to clone and then click Duplicate. When QuickBooks displays
the Duplicate User dialog box (see Figure 1-7), finish describing the new user, and
click OK.

USER NAME AND PASSWORD
User Name [oup Chiocy

Eassword (opfional}

Confirm Passward
ROLES
Ayallable Roles Agsigned Roles
External Accountant™ Accounts Receivable
Finance* < Bemove Banking
Full Access™t Inventory |
Fayroll Manager* Purchasing N
Fayroll Processor® Sales
R v v
Description

This rale is designed for your Bookkeeping or accounting s1afl. Access Lo areas activ.’es
guch as Journal Entrieg, Chart of Accounts, Setting Closing Date & Pagswo d
Accountant & Taxes and Company & Financial reports. This role neecs In uit acrount.

Provide user's email address and well send an invilelupdale to 202 ss Inluil account
roles.

User's email (optlonal)
*These roles give users unrestricted accass to vow Al ransactions, including payrall info.
Find out more

*These roles need an Intuit account. Read T about Intuit account

FIGURE 1-7: A
The Duplicate | /™! moema ol El -

User dialog box.

To remov= a user, you also use the Users and Roles dialog box. Simply select the
user and then click the Delete button. QuickBooks asks you to confirm your dele-
tion. When you click the Yes button (see Figure 1-8) for confirmation, QuickBooks
removes the user.

ﬂ Are you sure you want to delete "Dup1 Cblock™?

FIGURE 1-8: Yes “

The Delete User
dialog box.
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Changing user rights in QuickBooks
Pro and Premier

You can modify the rights that you assign to a user in QuickBooks Pro or Premier.
To do this, choose Company= Set Up Users and Passwords= Set Up Users to dis-
play the User List dialog box (not shown).

To look at the rights that a particular user has, select the user in the list and
then click the View User button. When you do, QuickBooks displays the View User
Access dialog box (not shown). This dialog box shows the same information as
the final version of the Set Up User Access and Password dialog box, which is the
dialog box that you use initially to specify what rights a user should have. Click the
Leave button to close the View User Access dialog box.

To change a user’s rights after reviewing them, select the user and then click the
Edit User button. QuickBooks steps through the same set of dialog boxes that you
use to set up the user and describe their rights. You use the Next and Back buttons
to do things such as change the username or password, specify whether the user
should be limited in their access, and — if necessary — to limit the user’s access
to a particular activity within QuickBocxs

To remove a user, you also use th= Jser List dialog box. Simply select the user
and then click the Delete Usei burton. QuickBooks asks you to confirm your dele-
tion (not shown). When you click the Yes button for confirmation, QuickBooks
removes the user.

Using Audit Trails

REMEMBER

If you aecide to allow multiple users access to the QuickBooks data file, you’ll
appreciate the QuickBooks Audit Trail feature, which keeps a record of who makes
what changes in the QuickBooks data file. This feature is always on, and you can
use it to determine whether information in the file changed and, if so, the user
who made the change.

You can’t remove transactions from the Audit Trail list or history except by
archiving and condensing data. Archiving and condensing data are described in
Book 7, Chapter 2.

To produce an Audit Trail report, choose Reports= Accountant and Taxes=> Audit
Trail. Figure 1-9 shows a QuickBooks Audit Trail report. Note that this report
identifies both the type of change made and the person who made the change in
the QuickBooks data file.
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FIGURE 1-9:

An Audit Trail

report.

Customize Report Commegt on Report | | Share Template  Memonze Print |+  Eamagl v | Excel ¥ | | Hide Header fiefrazh
Date Enteredlagt Modified  Cuslom = From | 01001/2020 B To 12512022 H
Show Filters.
Pine Lake Porcelain LLC
Audit Trail
EnterediLast Modified January 2020 through December 2022
Hum - Entered’Last Modified - Last modified by State Date Name Memo Account Split Debit Ci
Trangactions entered or modified by Admin =
s l
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=
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Enabling Simultaneous Multiuser Access

498

Sometimes, you need oiiy.a single computer and a single copy of QuickBooks,
even though you havs several employees using QuickBooks. If a small business
has only an adminisirative assistant and the owner accessing a QuickBooks data
file, for example, one copy of QuickBooks running on a single personal computer
may be all that's required. QuickBooks does allow for simultaneous use of the
QuickBcoks data file by multiple users, however. Predictably, you first need to set
up multipie users, as described earlier in this chapter.

After you’ve set up multiple users, you can install the QuickBooks program on
other personal computers and then — assuming that all these personal computers
connect to a Windows network — use those other copies of QuickBooks to access
the QuickBooks data file stored on the first or principal computer.

To use QuickBooks in an environment of simultaneous use by multiple users, you
also need to tell QuickBooks that simultaneous use is okay. To do this, choose the
File=>Switch to Multi-User Mode command. (If you want to turn off Multi-User
Mode later, choose File=> Switch to Single User Mode again.)
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WARNING

TIP

QuickBooks supports simultaneous use by multiple users through a technology
called record locking, which locks all the records that you’re working with but not
the entire QuickBooks data file. If you want to work with Company A, and some
other user wants to work with Company B, that’s okay. QuickBooks allows it.
What you and the other user can’t do, however, is work on the same company
(A or B) at the same time. This would mean that you’re working with the same
customer record.

You can’t install the same copy of QuickBooks on multiple machines and legally
have a multiple-user QuickBooks system. You must purchase a copy of Quick-
Books for each machine on which QuickBooks is installed. Note, however, that
Intuit does sell some multiple-user versions of QuickBooks in which you actually
buy five licenses in one box of QuickBooks. (The Enterprise version of QuickBooks
supports multiple-user networks with up to 40 simultaneous users, and the other
versions of QuickBooks support multiple-user networks with up to 5 simultane-
ous users.)

You may want to have several QuickBooks users if sales representatives in your
firm prepare invoices or prepare bids for cucivomers. In this case, you may want
to have each salesperson set up on Quici-Beoks. Note, however, that these sales-
people should have the ability only ta ¢reate an invoice or perhaps create and print
an invoice estimate. For reasons discussed more fully in the next section of this
chapter, you want to be very caz«ful about giving inexperienced accounting users
full access to the accounting/sysiem.

Maintaining Gead Accounting Controls

In the priceding paragraphs of this chapter, I talk about how QuickBooks allows
multiple users. Many businesses, after they grow to a certain size, need to sup-
port multiple users with access to accounting information and the capability, in
some cases, to create accounting transactions. Unfortunately, multiple accounting
system users create risk for the business owner. By having access to the account-
ing system, users can either inadvertently introduce errors into the accounting
system or (unfortunately) intentionally defraud a business. For these reasons, I
want to briefly list some QuickBooks control techniques that a business owner
or business manager can use to minimize unintentional errors and minimize the
opportunity for theft. Here are my best ideas:

3 Regularly compare physical inventory counts with inventory accounting
records. Inventory shrinks, unfortunately. People — sometimes employees,
but often pseudocustomers, such as shoplifters — steal inventory. Therefore,
one thing you need to do, both to minimize your inventory losses and to
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maintain accurate accounting records, is regularly compare physical counts of
your inventory with what your accounting records show. A small convenience
store, for example, may want to compare tobacco inventory on a daily basis,
beer and wine inventory on a weekly basis, and all other grocery inventory
items on a monthly or annual basis. This approach to frequently counting the
most valuable and easiest-to-steal items accomplishes two things:

® Inventory shrinkage is quickly identified.

© The business owner can minimize inventory shrinkage by identifying the
type of inventory that's most often stolen or even when inventory is most
often stolen.

Reconcile bank accounts. One thing that business owners should do, in my
opinion, is reconcile their own bank accounts. Often, employee theft by
accounting personnel occurs as employees figure out how to write checks on
the company’s bank account that the owner doesn't s2e..One sure way to find
a fictitious and fraudulent transaction is to have the owner reconcile the bank
statement. If the owner reconciles the bank statenent, they can compare the
bank’s accounting for the account with the campany’s QuickBooks accounting
records. Any obvious discrepancies can ke fixed, which means that the
QuickBooks accounting records are mor<-accurate. Additionally, any flaky,
suspicious transactions tend to bec: iie obvious when the business owner
looks closely at checks.

The first employee | ever hire<-was a check forger. He began forging checks
on one of my business.cnecking accounts two or three weeks after he started
working for me. | caugize him only because | was regularly reconciling the
checking account: (i== was convicted of a felony a few months later.)

Segregate accounting from physical custody where possible. In a small
business. /iU qifficult to always separate the accounting for some activity from
the plissical custody or physical responsibility for that activity. It's tough to
segrogate the inventory accounting from physical custody or access to that
inventory. A store clerk, for example, may easily be able to steal cigarettes and
also adjust inventory records through cash-register sales for cigarettes.
Nevertheless, wherever you can segregate physical custody from accounting,
built-in error checking occurs. The person doing the accounting indirectly
checks on the physical custodian’s caretaking of the asset. If the physical
custodian is stealing cartons of cigarettes, for example, that fact shows up
when the accountant compares the accounting records with the physical
accounts of inventory. Similarly, someone who doesn't have access to the cash
and the bank account can't easily steal cash, even if they have complete
access to cash accounting records. You can ask your CPA for help in devising
ways to segregate physical custody of assets from accounting and bookkeep-
ing duties. And you really, really should do this. Unfortunately, employee theft
is very common.
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Train employees in the use of QuickBooks. You should train employees to
use QuickBooks if you have a business of any size for two basic reasons:

® Someone who knows how to use QuickBooks is less likely to make inadvertent
errors. QuickBooks isn't difficult to use, but it's also not something that you
can learn willy-nilly with no help. Some transactions are pretty tricky,
particularly for certain businesses. So if you can, it makes good sense to
provide some employee help or training, or both. Those resources let
people use QuickBooks's features more comfortably and more accurately
to build financial information that lets you manage your business better.

® Messy accounting records camouflage employee theft. Often, one thing you
see when employee theft happens is really messed-up accounting records.
For that reason, you can find yourself in a situation in which poorly trained
employees create a messy accounting system that enables employee theft.
So training means not only that you'll have more 2<curate accounting
records, but also that you'll be less likely to have ain environment conducive
to theft or embezzlement.

Close your QuickBooks file. If you take a ’rinciples of Accounting course,
you'll discover that closing means a set o1 hookkeeping procedures that
somebody performs to zero out reveric e and expense accounts so that
starting in the new year, revenue-=:iu-expenses can be easily calculated. In
QuickBooks, closing means soiri-thing different. But you still want to close the
QuickBooks file to maintair. th= integrity of your data. Here's how: Choose the
Edit=>Preferences commeand, select Accounting in the Preferences dialog box,
select the Company.Fte‘erences tab, and then click the Closing Date Set Date/
Password button. When QuickBooks prompts you, specify a closing date and
password. Afteyou provide this information, QuickBooks prohibits or limits
users fromchanging or entering transactions dated before the closing date.
(Only psople with the password can make changes to or enter transactions
with date: earlier than the closing date.)

Mariage your QuickBooks accounting system. I'm sorry to report that many
business owners don't view the accounting system as being anything more
than a tool to produce invoices, paychecks, and information required for the
annual tax return. Unfortunately, that distant relationship with the accounting
system means that business owners often don't feel much need to actively
manage what happens with the accounting system.

In my opinion — an opinion based on more than 30 years of experience
working as a CPA — this attitude is wrong. An accounting system should be a
tool that you use to better manage your business. And it can be that. But if it's
going to be a tool for better managing your business, you need to manage the
system. In other words, | respectfully suggest that you take responsibility for
ensuring that employees are trained to do the things that protect your
accounting system (such as backing up the data file) and that you ensure that
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they complete appropriate accounting procedures on a monthly and annual
basis (such as sending out all invoices, reconciling bank accounts, cleaning up
messy transactions, and so forth).

| don't think that this management responsibility needs to be a heavy one.
You can rather easily make sure that people are doing the sorts of things
they're supposed to be doing by creating some simple checklists. Table 1-1
shows a sample monthly accounting to-do list. Table 1-2 shows a sample
annual accounting to-do list. You can use these tables as starting points for
constructing your own list of things that the accounting clerk or office
manager must do every month or at the end of every year.

TABLE 1-1 A Sample Monthly Accounting To-Do List

>
Task ~ Completed:

Data backed up and moved offsite

Bank accounts reconciled

All invoices, credit memos, statements out

Any suspense accounts cleaned up

Financial statements delivered

Exceptions reported (overdue invoices, bills, purchase orders,
understocked inventory itenic. .and so on)

TABLE 1-2 A Sample Annual Accounting To-Do List
Task ‘ : Completed?

Adjust trie! balance

Burn CD with year-end numbers for permanent record

Consider cleaning up data files if they're huge

Close year when really done
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